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Introduction 

This Job Aid is intended for all CONNECTIONS users. It provides a detailed overview of the 
CONNECTIONS system changes being introduced with Build 18.9.1.  

With the implementation of Build 18.9.1, several important changes will improve the 
CONNECTIONS system. It should be noted that many of the enhancements included in this 
Build originated from a collaborative effort on the part of OCFS, local district and voluntary 
agency casework and supervisory staff, who were members of the Functional Improvement 
Team (FIT). Specifically, this Job Aid contains information about enhancements in the following 
functional areas: 

• Approvals 

• Foster and Adoptive Home Development (FAD) 

• Family Assessment and Service Plans (FASPs), including Plan Amendments and 
Service Plan Reviews 

• FASP Reports 

• Health Services 

• Permanency 

• Person Search  

• Progress Notes 

• Security 

 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 

This Job Aid assumes familiarity with the 
CONNECTIONS System. 

 
This Job Aid is available online on the CONNECTIONS intranet site: 

DFA Intranet Site > OCFS Home page > CONNECTIONS >Desk and Job Aids 

 

The CONNECTIONS intranet site also contains information about CONNECTIONS training. 
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Approvals 

FASP Due Date 
The Approval To-Do created when a FASP is submitted now includes the FASP due date. This 
will allow workers to search for the To-Do based on the date the FASP is due. The FASP due 
date will display in the Due field on the To-Do Detail window, as well as in the Date column on 
the Staff To-Do List, for these To-Do’s. 

 
 

FASP Rejection Notification 
The supervisor of a Case Planner that has approved a FASP will now receive an Alert To-Do if 
that FASP is later rejected by the Case Manager. The To-Do will be identical to the one sent to 
the submitter of the FASP when it was rejected. 

 

Rejected To-Do’s 
The following modifications were made to the Approvals process for rejected To-Do’s: 

• When a FASP is approved, any Removal Update To-Do’s in “Rejected” status are 
deleted. 

• When a FASP is approved, any FSS Stage Closure To-Do’s in “Rejected” status are 
deleted, along with their associated events. 

• When a FAD Reauthorization is approved, any FAD Stage Closure To-Do’s in 
“Rejected” status are deleted. 
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Foster and Adoptive Home Development (FAD) 

Fingerprint Letters 
On January 11, 2007, foster boarding home and adoption regulations were amended to require 
FBI fingerprint checks for prospective foster and adoptive parents and those persons age 18 
and over in the household. CONNECTIONS does not currently support these new regulations; 
consequently, the ability to access the fingerprint notification and denial/revocation letter (and 
the associated Spanish translations) in CONNECTIONS has been disabled. Note that workers 
are still required to provide the fingerprint notice to applicants and other adults in the household 
and the denial/revocation letter as appropriate, but they must use the revised documents found 
in 07-OCFS-ADM-01. To view this Administrative Directive Memo (ADM), access the OCFS 
intranet site (http://ocfs.state.nyenet/connect/), click on Policies – External (under General 
Resources), and then click on the Administrative Directives link. 

Refer to Appendix A to review copies of the Notification and Denial/Revocation letter. 

 

FAD Home Certificates and Approval Letters 
Out-of-state foster and adoptive homes in which New York State children are placed are 
licensed by their home state, using the home state’s licensing criteria. They are not certified or 
approved by New York State. For this reason, the ability to print FAD Home Certificates and 
Approval Letters for out-of-state homes has been disabled in CONNECTIONS. 

An additional change made to the FAD functionality with the implementation of Build 18.9.1 is 
the addition of drop-down menus were added to the pop-up windows that originate from the 
Foster and Adoptive Home Record Summary window in order to make them consistent with the 
rest of CONNECTIONS. The commands in the new File, Options and Help menus mirror the 
buttons that are on the window. 

 

http://ocfs.state.nyenet/connect/
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Family Assessment and Service Plans (FASPs) 

Family Update 
The Presenting Needs and Concerns tab for the Family Update has been relabeled “Original 
Reason for Case Opening.” The text on the tab describing what workers should enter in the 
narrative has been changed to the following to reflect this change:  

“Summarize the original reason for case opening. Identify the area the family 
considered most important to address.” 

 
 

In addition, once an Initial FASP has been approved, subsequent FASPs will display the Family 
Background tab as the “active” tab when a worker enters the Family Update window (although 
the Original Reason for Case Opening tab will be available in view-only mode). Entries in the 
Original Reason for Case Opening tab will be time-stamped each time an entry is made or 
modified until the Initial FASP is approved. 

 

Strengths, Needs and Risks 
The Strengths, Needs and Risks scales for Parents/Caretakers and Children will be pre-filled in 
Reassessment FASPs from the last approved Comprehensive or Reassessment FASP. The 
comments associated with the scales will also be pre-filled. If the scales are pre-filled, they will 
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be listed on the Check FASP Detail Component Status window until they have been accessed 
by the worker to ensure that they are reviewed. It is very important that workers review the 
scales carefully and update them as necessary in each FASP cycle; this is essential to the 
successful development of the Service Plan.  

In addition, each item in the Scale column will now be numbered and each item in the Ratings 
column will be preceded by a letter (“a” through “d”), to make it easier to reference specific 
scales in the Comments section. 

 

Life Skills Assessment 
The Life Skills Assessment scales will be pre-filled in the Comprehensive and Reassessment 
FASP from the last approved FASP. If the scales are pre-filled, they will be listed on the Check 
FASP Detail Component Status window until they have been accessed by the worker to ensure 
that they are reviewed. It is very important that workers review the scales carefully and update 
them as necessary in each FASP cycle; this helps ensure that the appropriate Service Plan is 
developed for the child. 
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FASP Reports 

Print Selected FASP Report Components 
The FASP Report Components window, which can be used to select specific components to be 
included in a printed FASP Report, has been added for approved FASPs. This window is 
accessed from the Print Selected button on the Full FASP Report window. The Print button on 
the Full FASP Report window for approved FASPs has been renamed “Print All”; clicking this 
button will print the entire FASP report. The Print Selected functionality is only available for 
FASPs that have been approved; the FASP Report window for In Process FASPs has a Print 
button for printing the entire report. 
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Step-by-Step: 
Printing an Approved FASP Report 

CONNECTIONS –System Build 18.9.1 Job Aid (08/20/2007) 

1 Access the Family Assessment and Service Plan 
window. 

2 On the Family Assessment and Service Plan window, 
click on an approved FASP in the FASP tree. 
The FASP Report window displays.  

3 Click on the Print All button to print the entire FASP 
report.  
The entire FASP Report prints. 

—OR— 

Click on the Print Selected button to print only specific components of the FASP 
report. 
The FASP Report Components window displays.  

 
Where am I? 

Assigned Workload > Tasks > 
Family Assessment and Service 

Plan tab 

4 On the FASP Report Components window, click on the checkbox(es) to select which 
components to include in the printed FASP Report. 
The OK button enables.  

5 Click on the OK button. 
The FASP Report prints with only the selected component(s) included.  

 

Foster Care Issues 
The Foster Care Issues section of the FASP Report has been modified so the information is 
now arranged by child. The child’s name now appears once, under the Appropriateness of 
Placement heading (for a full FASP report), followed by all of the Foster Care Issues nodes and 
sections for that child. For a component report, information is displayed by child for each 
component. 

In addition, the following modifications were made: 
• Page breaks were added after the information for each child, between the last child 

and the Visiting Plan, and between the Visiting Plan and Visiting Grid sections. 

• If the Discharge information was recorded in the FASP, it will now be displayed 
before the Visiting Plan/Visiting Grid sections. 

 

Refer to Appendix B to view an example of the Foster Care Issues section of the FASP Report 
output. 
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The following additional changes were made to FASP Reports with the implementation of Build 
18.9.1: 

• The information that was previously displayed in the header of the FASP Report 
output will now be displayed on the first and signature pages only, with a subset of 
this information in the header of all other pages. In addition, the following two labels 
have been modified to make them clearer: 

o “District with Case Management” has been relabeled “LDSS with Case 
Management.”  

o “District/Agency with Case Planning” has been relabeled “LDSS/Agy with Case 
Planning.”  

• Only workers currently assigned to the stage will display in the FASP Report. 
Unassigned workers have been removed from the “Worker Information” section of 
the FASP Report and the End Date column has been removed. 

• The following text was added to the beginning of the Service Plan section of the 
FASP Report output (but not on the actual window in CONNECTIONS): 

“The service plan described on this and any attached pages, represents 
a plan to help you meet the most important needs of your family. It is 
important that you read and understand this plan. It may be used to 
review agreed upon activities and to review progress.” 
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Health Services 

Primary Care/Medical Home 
Prior to the implementation of Build 18.9.1, the only way to access the Primary Care/Medical 
Home window was through an Options menu item. To make navigation to this window easier, 
the Primary Care/Medical Home button has been added to the Child Health Info tab. The 
Primary Care/Medical Home button opens the Primary Care/Medical Home window, which 
provides for viewing and selecting the primary care/medical home for a child. This button is 
enabled when a child is selected in the Child List and there are no unsaved changes on the 
Child Health Info tab.  

In addition, to make the system more flexible, the primary care medical/home can now be 
selected from any health provider associated with the stage; it no longer is required to be 
affiliated with a “Physical/Medical” domain type. 
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Step-by-Step: 
Accessing the Primary Care/Medical Home 

1 Access the Health Services window. 

CONNECTIONS –System Build 18.9.1 Job Aid (08/20/2007) 

2 Access the Child Health Info tab. 
3 With a child selected in the Child List grid, click on 

the Primary Care/Medical Home button. 
The Primary Care/Medical Home window displays. 
Note that this button is disabled when there are 
unsaved changes on the Child Health Info tab. 

 

Health Providers 
Prior to the implementation of Build 18.9.1, workers used the Health Provider button on the 
Clinical Appointment tab to link a health provider to a clinical appointment; information about 
the health provider could not be modified using this path. To modify a health provider, workers 
had to select the Add/Modify Health Providers command from the Options menu on the 
Clinical Appointment Health Provider window.  

To make navigation easier and more intuitive, the Add/Modify Prov. button has been added 
and the Health Provider button has been renamed “Select Health Provider” on the Clinical 
Appointment tab. A system status message was also added to the Clinical Appointment tab 
that states:  

"Add or Verify Health Provider Exists prior to entering Clinical Appointment." 
 

The Select Health Provider button opens the Clinical Appointment Health Provider window, 
which lists all previously-saved health providers for the child. When the Clinical Appointment 
Health Provider window is accessed using this button, it can be used to link a provider to the 
clinical appointment; however, health provider information cannot be added or modified this 
way. This button is enabled when a worker initially adds a clinical appointment or when an 
unsaved record is selected in the History grid. 

 
Where am I? 

Assigned Workload > Tasks > 
Health Services tab 

 
It is best to record each health 
provider’s information prior to 

adding the health record 
information; this makes the 

provider available for linking to 
an appointment.  

The Add/Modify Health Prov. button opens the Clinical 
Appointment Health Provider window where you can add or 
modify information for the child's health providers. This button 
is enabled when there are no unsaved changes on the 
Clinical Appointment tab. 
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Step-by-Step: 
Linking a Health Provider to a Clinical Appointment 

1 Access the Clinical Appointment tab. 
2 With a child selected in the Child List grid, enter all 

of the appropriate information for the clinical 
appointment. 

3 Click on the Select Health Provider button. 
The Clinical Appointment Health Provider window 
displays.  

 
Where am I? 

Assigned Workload > Tasks > 
Health Services tab > Clinical 

Appointment tab 

4 Select a health provider in the Resource List grid. 
The health provider’s information displays in the detail fields. 

5 Click on the OK button. 
The Clinical Appointment tab displays. 
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6 Click on the Add button. 
The clinical appointment displays in the History grid, with the health provider’s name 
in the Provider column. 
If you have not already added a Health Provider, the following message displays: 
“After saving this record you will not be permitted to add a Health Provider. Would 
you like to add a Health Provider?  
Click on the Yes button to add a health provider. 
—OR— 

Click on the No button to save the record without a provider. 
The Save button enables. 

7 Click on the Save button. 
The clinical appointment is saved and all Health Services tabs become enabled. 

 

 

Step-by-Step: 
Adding a Clinical Appointment Health Provider 

1 Access the Clinical Appointment tab. 

 
Where am I? 

Assigned Workload > Tasks > 
Health Services tab > Clinical 

Appointment tab 

2 Click on the Add/Modify Prov. button.  
The Clinical Appointment Health Provider window 
displays.  

3 In the Resource Name field record appropriate 
information.  

4 Record the primary street address in the Street field.  
5 Record the second line of the address in the P.O. Box/Apt field, if applicable.  
6 Record the city in the City field.  

7 Select the appropriate state by clicking on the drop-down arrow in the State field.  

8 Enter the ZIP Code of the court in the Zip field.  

9 Validate the address by clicking on the Validate button. 
The address validation window displays.  

10 Click on the Accept button to accept the validated address.  
Proceed to Step 11. 

—OR— 

Click on the Reject button to reject the validated address. 
You must reenter an address and repeat Step 9 in order to save the record. 

11 If available, record the telephone number in the Number field. 
The Add button enables.  
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12 Click on the Add button. 
The record is added to the grid. The Save button enables.  

13 Click on the Save button. 
The Clinical Appointment tab displays. 

 

The following additional changes were made to the Health Services module with the 
implementation of Build 18.9.1: 

• To increase the flexibility of the system, the edits have been removed so that any 
combination of domain types can be selected in the Domain Type field on the 
Clinical Appointment tab. When multiple domain types are selected, "Multiple" 
displays in the Domain Type field.   

• Workers can now backdate the Date of HIV Test on the HIV Risk Assessment tab 
to the child's date of birth. 

• To improve the ease of navigation, workers are no longer required to answer the 
Biological Mother questions before they can access the Additional Information 
window. The Additional Information button on the Bio. Family Health Info tab will 
be only be disabled when there are unsaved changes on the window. 

• The child's demographic information is now pre-filled on the Authorization to Release 
Foster Child's Health Records form and Request for Past Medical and 
Psychological/Psychiatric Health Records form. 

• The names of the biological parents have been removed from the biological family 
health section on the Child Health Summary and Child Health History Reports. This 
has been done to prevent this information from being shared with those permitted or 
required to have the child’s health information, but not the identity of the child’s 
biological parents. Note that these names have been removed from the report 
outputs only and not from the actual windows in CONNECTIONS. 
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Permanency 

Mail Local Copy 
Prior to the implementation of Build 18.9.1, workers were able to email the Permanency Hearing 
Report to their own email account. With the implementation of Build 18.9.1, workers will have 
the ability to email the Permanency Hearing Statement, in addition to the Permanency Hearing 
Report. The Permanency Hearing Statement and Permanency Hearing Report options were 
added under Mail Local Copy in the Options menu on the Permanency window. These options 
can be used to email a copy of the Permanency Hearing Report or Statement to the logged-on 
worker. Emailing a report or statement enables the worker to store it so that it can be sent to 
required reviewers (e.g., supervisor, attorney). A report or statement may be emailed multiple 
times. The Mail Local Copy option enables when a row in the Permanency Report Summary 
grid is selected on the Permanency window. 

 

Although the Permanency Hearing Report and Statement may be emailed to the court prior to 
the Date Certain, an original, sworn copy must also be filed with the court prior to the Date 
Certain. 
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Step-by-Step: 
Emailing a Local Copy of a Permanency Hearing Report or Statement 

 
Where am I? 

Assigned Workload > Tasks > 
Permanency tab 

1 Access the Permanency window. 

2 Select the desired Permanency Hearing Report from 
the Permanency Report Summary grid by clicking 
on the box to the left of it.  

3 Click on the Options menu and select the Mail Local 
Copy command. 
The Mail Local Copy sub-menu items display.  

4 Select the Permanency Hearing Report or Permanency Hearing Statement sub-
menu item. 
A copy of the report or statement is emailed to the logged-on worker.  

For an Individual or Freed Child report, the subject of the email will be: 

Permanency Hearing Report: “Single S-<Stage ID> <Last Name> <First 
Name> R-<Report ID>” 

Permanency Hearing Statement: “Statement S-<Stage ID> <Last Name> 
<First Name> R-<Report ID> “ 

For a Multiple Child report, the subject of the email will be: 

Permanency Hearing Report: “Multiple S-<Stage ID> Multiple R-<Report ID>” 

Permanency Hearing Statement: “Statement S-<Stage ID> Multiple R-
<Report ID> “ 

When the worker selects the Permanency Hearing Report or Permanency Hearing 
Statement sub-menu item, the following message displays:  

"The report/statement will be mailed to XXXXXX@nysemail.state.ny.us. If you 
cannot access this mailbox, contact the Case Manager. Do you wish to proceed 

with the mailing?   

Click on the Yes button to proceed. 

If the logged-on worker’s email address cannot be found in the global address book, 
the following message will display: 

  “The Logged On user cannot be found in the HSEN email system. This report 
can only be emailed from CONNECTIONS to a logged on user who is found in the 

HSEN email system. Please contact the case manager or other person with 
access to the case who is in the HSEN email system to log on and have the report 

emailed.” 

Click on the OK button to close the message. 
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5 Once a report or statement has been emailed to the logged-on worker, that worker 
must open it and apply password protection before it can be forwarded to anyone. 
This requirement is crucial to avoid revealing confidential material to unauthorized 
individuals, should the report/e-mail be misdirected by being sent to the wrong email 
address(es). Passwords must never be sent with the emailed report; they must 
be transmitted separately.  
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Caseworkers Grid 
To give workers the ability to select caseworkers they want to display on the Permanency 
Hearing Statement, the Caseworkers grid, which contains all workers assigned to the stage 
(with the exception of the Case Manager), has been added to the Court Information window. 
Workers can select one or more worker(s) from the grid; these workers will display in the "Case 
Worker Name" field on the Permanency Hearing Statement.  

 
 

Important! When forwarding this report, security guidelines for 
emailing must be followed. To review these guidelines: 

 
• Navigate to the CONNECTIONS intranet site.  
• Click on the Security link.  
• Access “Guidelines for using Electronic Communication for 

Sharing Case Specific Information.” 

 
Within NYC ACS, a Notice Grid is the document 
used to list all relevant case respondents, not the 

Permanency Hearing Statement generated by 
CONNECTIONS. 
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Step-by-Step: 
Selecting a Caseworker to Display on the Permanency Hearing Statement 

1 Access the Court Information window. 
2 Click the checkbox next to one or more workers in 

the Caseworkers grid that you want to include on the 
Statement. 

3 Enter the appropriate information in the Family 
Court Address and Hearing Information sections of 
the window. 
The Save button enables. 

4 Click on the Save button to save the information on the window. 

 
Where am I? 

Assigned Workload > Tasks > 
Permanency tab > Notices and 

Statement button > Court 
Information button 

5 Click on the Close button to close the Court Information window. 
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The following additional changes were made to the Permanency module with the 
implementation of Build 18.9.1: 

• If the Case Manager is from ACS, once a worker has invited at least one person to 
the permanency hearing on the Permanency Hearing Notices and Statements 
window, the Permanency Hearing Statement will be available to be printed from the 
Reports menu. Court information does not need to be completed. 

• The VA Workers grid on the Permanency Hearing Notices and Statements window 
has been relabeled "Workers" and has been modified so it populates with all workers 
who have a role in the stage (instead of only voluntary agency workers). Workers 
selected in this grid can be added to the list of invitees for a permanency hearing. 

• The Docket Number field on the Court Information window has been relabeled 
"Docket Number(s)" and its text field length has been increased from 20 to 120 
characters so that multiple docket numbers can be entered. 

• The Permanency Hearing Notice has been revised and now includes the child’s CIN 
and the most recent revision date (2006). 
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Person Search 

Staff Person ID 
An employee’s Person ID (PID) should never be listed as part of the stage composition. If an 
employee is also part of a stage, s/he should have two PID’s in CONNECTIONS: one as an 
employee and one as part of the stage composition. For this reason, with the implementation of 
Build 18.9.1, workers can no longer merge, relate or view the Case List for a staff person. When 
an employee’s Person ID is selected in the Person Search results on the Person Search or 
Add/Relate Person windows, the following message is displayed:  

“This person is an employee. For more information use Staff Search.” 

Clicking the OK button closes the message window. 

When a staff person is selected in one of these windows, the Case List and Relate buttons 
(and corresponding Options menu commands) will be disabled. On the Person Search window, 
the Person Merge/Split command in the Options menu will also be disabled.  

Workers will also not be able to enter an employee as the Person Forward on the Person 
Merge/Split window. If a worker attempts to do this, the following error message is received 
upon validating the PID: 

“Pers Forward is Employee or fmr Employee. Merge is not allowed.” 
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Plan Amendments 

When completing Plan Amendments, it has always been a requirement to document the status 
change that occurred. However, prior to the implementation of Build 18.9.1, it was possible to 
submit a Plan Amendment for approval without selecting a status change. With the 
implementation of Build 18.9.1, workers will no longer be able to submit a Plan Amendment for 
approval when no status change has been selected and completed. This modification puts in 
place a system edit for what has always been required programmatically. In addition, an 
enhancement was made to the system to make it easier to navigate to the Plan Amendment 
Maintenance window; this window now opens automatically upon launching a Plan Amendment. 
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Progress Notes 

Save and Enter New Note 
In order to facilitate the recording of successive progress notes, the Save and Enter New Note 
button was added to the Progress Notes Detail window. This button saves the current progress 
note in "Draft" status and clears all fields on the Progress Notes Detail window. The Save and 
Enter New Note button is enabled when all required fields have been entered in a new or 
"Draft" progress note. 

The Save and Enter New Note functionality can save workers valuable time as it allows them to 
add new progress notes directly from within a note they are working on, without having to return 
to the Progress Notes window. 
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New Using 
The New Using command was added to the Options menu on the Progress Notes window. 
The New Using functionality can be a useful tool for workers, as it allows them to use a 
previously-recorded progress note as a starting point for a new note, saving the time required to 
specify all of the notes details and letting them focus on simply writing the narrative. 
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When a worker selects a note in the Search Results grid in the Progress Notes window, then 
selects the New Using command from the Options menu, a new Progress Notes Detail window 
displays with the following fields pre-filled from the selected progress note: 
 

• Type  
• Method of Contact  
• Location of Contact  
• Other Participant  
• Purpose  
 

Note that workers can modify these pre-filled fields. 
 
 

 

Step-by-Step: 
Creating a New Progress Note from an Existing Note 

1 Access the Progress Notes window. 
2 Select an existing progress note in the Search 

Results grid. 

3 Select the New Using command from the Options 
menu. 
The Progress Notes Detail window displays with the 
Type, Method of Contact, Location of Contact, 
Other Participant and Purpose fields pre-filled from the selected progress note. 

4 Make any necessary modifications to the pre-filled fields. Note that workers can 
modify the pre-filled fields in the new progress note created using the New Using 
option. 

 
Where am I? 

Assigned Workload > Tasks > 
Progress Notes tab 

 
If you change the Type or Method of Contact while 
entering a Progress Note, the following messages 

will appear:  
"Changing TYPE will clear all user entered data 
fields except the Narrative.  Continue making 

changes? Yes/No"  
and  

“Changing METHOD may clear the user entered 
data fields that are inconsistent with the new 

METHOD selection.  Continue making changes? 
 Yes No" 

5 Record the narrative of the 
progress note in the Narrative 
field. 

6 Once all of the required fields are 
recorded, click on the Save as 
Draft or Save as Final button.  
The following message will 
display: “Changes have been 
saved.”  

7 Click the OK button. 
The Progress Notes window 
displays with the new note listed.  
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“Draft” Progress Notes 
Progress notes will now be frozen and unavailable for edit at day 20, rather than at day 15. This 
change has been made in order to support supervisors' ability to review staff progress notes 
and to direct staff to provide necessary clarification and accurate detail. The standard for the 
contemporaneous recording of progress notes has not changed. As a business record, the 
progress notes must maintain accurate and timely information that is available to all 
caseworkers and supervisors with a role in the case. The addition of days to the period for 
progress note review by supervisors does not change the requirement for the prompt entry of 
notes into the record in CONNECTIONS. 

In addition, the amount of information in the header of printed progress notes has been 
decreased; now only the first page will display the full header information and subsequent pages 
will display a subset of this information.  
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Security 

After the implementation of Build 18.9.1, if the district or agency has set up an Organizational 
Hierarchy and has enabled a Direct Supervisory Line for either All Staff or All Non-Clerical Staff, 
the workers in units above can be “in”-assigned or “out”-assigned to the unit above and will have 
view or maintain access to the workloads of all staff in the unit(s) below.  These workers will 
have view or maintain access to the entire workload of the worker in the unit below dependent 
upon which radio button (View or Maintain) was selected on the Agency Access window.  The 
workloads of staff members, whether they are “in”- or “out”-assigned, in the units below in the 
direct supervisory line can be viewed or maintained by the staff in the unit above them in the 
Organizational Hierarchy. 

 
If a worker has not been assigned a Job Type on the Staff Security window, the system will 
assign the worker a category of “Clerical” by default. Therefore, if access (view or maintain) is 
assigned to All Non-Clerical Staff in the Direct Supervisory Line section of the Agency Access 
window, a worker who has not been assigned a job type (and has been given the Job Type of 
“Clerical” by default) will not be granted access via the Organizational Hierarchy.  
 
 

 
The changes to Security described above 

apply to FSI and FSS stages only. 
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Service Plan Reviews 

With the implementation of Build 18.9.1, space was added to the top margin of the Service Plan 
Review Notification Letter so it can be printed on letterhead. 



 

Page 26 

Support Tools 

Online Help 
CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-step 
instructions for common tasks. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-instructions to help you complete tasks using 

CONNECTIONS.  
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality.  
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window you 
will see additional buttons and menus. Use the Search button to search for specific 
information in the Help function and use the Back button to return to windows you 
have just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you are done reviewing information in Help, close each Help window by 
clicking on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). Release Notes – a complete list of the modifications, 
enhancements, fixes and impacts in the Build – is also available from the CONNECTIONS 
intranet site. 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your local desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. For access to various Step-by-Step Guides 
and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to Release 
Notes for a Build, click on the Implementation link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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Appendix A: 
 

FAD Fingerprint Notification and Denial/Revocation Letter 



 

 

NEW YORK STATE OFFICE OF CHILDREN AND FAMILY SERVICES  

NOTICE REGARDING FINGERPRINTING REQUIREMENTS 

 

This notice is to advise you that New York State law (section 378-a of the Social Services Law) 
requires you and those persons over the age of 18 who currently live in your home to be 
fingerprinted if you are applying to be certified or approved as a foster parent (including a 
relative foster parent) or an adoptive parent.  The fingerprints are used to conduct a national 
criminal history record check through the Federal Bureau of Investigation (FBI) and a New York 
State criminal history record check through the Division of Criminal Justice Services (DCJS).  

 

The social services district or voluntary authorized agency with which you are seeking 
certification or approval will ask you and all of the above noted household members to have 
fingerprints taken.  It will give you a listing of one or more places where you and those 
household members may go to have the fingerprints taken.  It will give you blank fingerprint 
cards and mailer for each person who must be fingerprinted.  The person or place actually 
taking the fingerprints may charge you a fee for taking the fingerprints. 

  

After the fingerprints are taken, they will be sent to the Office of Children and Family Services 
(OCFS).  OCFS will then send them to DCJS and the FBI to search their agency files for any 
criminal record of charges or convictions in New York State or nationally.  There is no fee to you 
for these searches. 

 

If in any search a criminal record is found, the social services district or voluntary authorized 
agency will receive summary information about the charges or convictions.  (When application is 
made to a voluntary authorized agency, specific charges or convictions reported by the FBI 
involving you and those persons over the age of 18 who currently live in your home will only be 
provided to the voluntary authorized agency when OCFS receives the consent addressed in the 
notice section below.) 

 

Depending upon the types of crimes listed in the criminal history, the following actions could 
result:  

• denial of your application; 
• revocation of your certification or approval;  
• removal of children  already placed in your home.  
 

You will be provided notice and reason for such actions if they are taken.  In the event your 
application is denied or your certification or approval is revoked, you will be provided with a copy 
of the summary of the criminal history record.  

You will also be given a notice which provides a description of the process DCJS and the FBI 
have for persons to review their criminal history record and any rights to challenge the action 
taken. 



 

 

Please be advised:  If you are an applicant or a certified or approved foster or adoptive parent 
and you have been convicted of a presumptive disqualifying crime, your application will be 
denied or your certification or approval revoked UNLESS you demonstrate to the social services 
district or voluntary authorized agency: 

 

• that the denial or revocation will create a unreasonable risk of harm to the 
physical or mental health of the child, and  

• that approval of your application or continuance of your certification or approval 
will not place the child’s safety in jeopardy and will be in the best interests of the 
child.  

 

Presumptive disqualifying crimes include certain felonies such as child abuse or neglect; 
spousal abuse, crimes against children, and certain crimes of violence. 

 

DCJS retains your fingerprints until your home is closed or an adoption is finalized.  While it 
retains the fingerprints, DCJS will notify OCFS (which will then notify the social services district 
or voluntary authorized agency) if you or anyone fingerprinted under this law is charged with a 
crime.  The FBI does not retain fingerprints.   

 

All criminal history record information is confidential.  It may not be made available for public 
inspection.  However, it may be disclosed for judicial or administrative proceedings relating to a 
denial of an application, revocation of a certificate or approval, or the removal of foster children.  
Where there is a pending court case, a copy of the summary of the criminal record will be 
provided to the Family Court or Surrogate’s Court. 

 

NOTICE TO PERSONS APPLYING TO A VOLUNTARY AUTHORIZED AGENCY  [THIS 
DOES NOT APPLY TO PERSONS APPLYING TO A SOCIAL SERVICES DISTRICT]:   

 

For a person who is applying to a voluntary authorized agency for certification or approval as a 
foster or adoptive parent and all other persons over the age of 18 who currently live in the home 
of the applicant, you will each be given a consent to sign called the “Acknowledgement and 
Consent for Fingerprinting and Disclosure of Criminal History Information”. The purpose of the 
consent is to authorize OCFS to provide the voluntary authorized agency with certain specific 
information on any crime or crimes reported to OCFS by the FBI.  The failure to sign the 
consent is a reason by itself to deny the application for certification or approval.  Also, if 
someone subject to the fingerprint requirement refuses to sign a consent, and the FBI has 
reported to OCFS that the person has a conviction or charge, OCFS regulations require the 
voluntary authorized agency to deny the application for certification or approval. 

 

We have a mutual interest in protecting the safety of foster children. These requirements are 
important in meeting that goal. 



 

 

OFICINA DE SERVICIOS PARA NIÑOS Y FAMILIAS 

 DEL  ESTADO DE NUEVA YORK 

 

NOTIFICACION ACERCA DE LOS REQUISITOS 

DE HUELLAS DIGITALES O IMPRESIONES DACTILARES 

 

El propósito de esta  notificación es informarle que la ley del estado de Nueva York (Sección 
378-a de la Ley de Servicios Sociales) requiere que usted y todos aquellos individuos mayores 
de 18 años de edad que actualmente residen en su hogar provean huellas digitales, si es que 
usted está aplicando para ser o ya es un(a) padre/madre de crianza certificado(a) o 
aprobado(a) (incluyendo a un familiar que asume el papel de padre/madre de crianza) o está 
solicitando para ser un(a) padre/madre adoptivo(a).  Las huellas digitales se usan para llevar a 
cabo verificaciones de historiales criminales a nivel nacional, a través de la Agencia Federal de 
Investigaciones (Federal Bureau of Investigation—FBI), y a nivel estatal, a través de la División 
de Servicios de Justicia Criminal (Division of Criminal Justice Services—DCJS). 

 

El distrito de servicios sociales de su localidad o la agencia voluntaria autorizada mediante la 
que está tratando de obtener certificación o aprobación pedirá que usted y todos los miembros 
de su hogar citados anteriormente provean huellas digitales. Se le dará una lista de uno o más 
lugares donde usted y los miembros de su  hogar podrán presentarse para que se tomen 
impresiones de sus huellas digitales.  A usted se le proveerá tarjetas de impresión de huellas 
digitales en blanco y un sobre para que las envíe para cada persona que debe proveer huellas 
digitales.  Es posible que se le cobre un honorario por el proceso de tomar huellas digitales. 

 

Después de haberse tomado las huellas digitales, éstas serán enviadas a la Oficina de 
Servicios para Niños y Familias (Office of Children and Family Services).  La OCFS las enviará 
a la División de Servicios de Justicia Criminal y al FBI para investigar los archivos de sus 
respectivas agencias con el fin de identificar cualquier récord criminal de cargos o convicciones 
en el estado de Nueva York o en la nación.  Las investigaciones son gratuitas.   

 

Si durante la investigación se encuentra un récord criminal, el distrito de servicios sociales o la 
agencia voluntaria recibirá un resumen de los cargos o convicciones.  (Cuando la solicitud se la 
dirija a una agencia voluntaria autorizada, los cargos o las convicciones específicas reportadas 
por el FBI involucrándole a usted y a aquellas personas mayores de 18 años de edad que viven 
en su hogar sólo se proveerán a la agencia voluntaria autorizada cuando OCFS reciba el 
consentimiento referido más abajo. 

 

Dependiendo de los tipos de crímenes listados en el historial criminal, las siguientes acciones 
pueden llevarse a cabo:  

 



 

 

• rechazo o negación de su  aplicación; 
• revocación de su certificación o aprobación; 
• retiro de los niños ya colocados en su hogar. 

 

Se le proveerá una notificación explicándole las razones de tales acciones, si éstas se llevan a 
cabo.  En caso de que su solicitud sea rechazada o negada, o de que su certificación o 
aprobación sea revocada, se le proveerá una copia del resumen del historial criminal. 

 

A usted también se le notificará una descripción del proceso que DCJS y el FBI utilizan para 
que una persona pueda revisar su historial criminal y cualquier derecho que esa persona pueda 
tener para objetar a la acción efectuada. 

 

Por favor tenga en cuenta: Si usted es un solicitante o un  padre/madre de crianza o 
adoptivo(a) aprobado(a) o certificado(a), y usted ha sido convicto de un crimen que 
presuntamente lo descalifica, su aplicación será negada/rechazada o su certificación o 
aprobación revocada A MENOS que usted demuestre al distrito de servicios sociales o a la 
agencia voluntaria autorizada que:  

 

• el rechazo o la revocación creará un riesgo irrazonable de daño a la salud física o 
mental del niño(a); y  

• la aprobación de su solicitud o la continuación de su certificación o aprobación no 
pondrá al niño(a) en peligro y protegerá los intereses del niño(a). 

 

Los crímenes que presuntamente descalifican a una persona incluyen ciertos delitos mayores, 
tales como abuso o negligencia infantil, abuso doméstico, crímenes contra niños y ciertos 
crímenes violentos. 

 

Las impresiones dactilares o huellas digitales serán retenidas por DCJS hasta que su hogar se 
cierre o hasta que se finalice una adopción.  Mientras DCJS retenga las huellas, la división 
notificará a OCFS (la que luego notificará al distrito de servicios sociales a o a la agencia 
voluntaria autorizada) si usted o cualquier persona que haya provisto huellas digitales bajo la 
ley haya sido cargada con un crimen.  El FBI no retiene huellas digitales. 

 

Toda la información relativa a historiales criminales es confidencial y no está disponible al 
público. Sin embargo, puede ser divulgada  para propósitos de procedimientos judiciales o 
administrativos relacionados al rechazo de una aplicación, a la revocación o aprobación de un 
certificado, o al retiro de niños de crianza.  Cuando haya un caso pendiente en el tribunal, se 
proveerá una copia del resumen del historial criminal al Tribunal de Relaciones Familiares o al 
Tribunal Testamentario.  

 
NOTIFICACIÓN A PERSONAS APLICANDO A UNA AGENCIA VOLUNTARIA AUTORIZADA 
(NO SE APLICA A PERSONAS SOLICITANDO A UN DISTRITO DE SERVICIOS SOCIALES): 



 

 

 

Para una persona que está aplicando a una agencia voluntaria autorizada con el fin de obtener 
certificación o aprobación para ser padre/madre de crianza o adoptivo(a), y para todas las otras 
personas mayores de 18 años que actualmente viven en el hogar del solicitante, cada uno será 
provisto con un formulario de consentimiento que debe firmarse, llamado “Reconocimiento y 
Consentimiento para la Obtención de Huellas Digitales y la Divulgación de Información de 
Historiales Criminales” (Acknowledgement and Consent for Fingerprinting and Disclosure of 
Ciminal Histsory Information).  El propósito del consentimiento es autorizar a que OCFS provea 
a la agencia voluntaria autorizada cierta información sobre cualquier crimen o crímenes 
reportados a OCFS por el FBI.  El no firmar el consentimiento constituye razón suficiente para 
rechazar la solicitud de certificación o aprobación.  Si el sujeto que debe proveer huellas 
digitales se rehúsa a firmar el consentimiento, y el FBI ha reportado a OCFS de que la persona 
tiene una convicción o  un cargo criminal, las regulaciones de OCFS requieren que la agencia 
voluntaria autorizada rechace o niegue la respectiva solicitud de certificación o aprobación. 

 

Nuestro interés es proteger la seguridad de los niños de crianza.  Estos requisitos son 
importantes para satisfacer nuestra meta. 



 

 

DENIAL / REVOCATION LETTER / NOTICE OF RESULTS OF FINGERPRINTING / 
CRIMINAL RECORD FOUND 

 

                                                                                                              Date:                        

                                                                                                              Re: 

                                                                                                              Name: 

                                                                                                              DOB: 

                                                                         Agency ID:                  NYSID No.: 

              

Dear Sir/ Madam: 

 

Pursuant  to Section 378-a of the Social Services Law, the Division of Criminal Justice Services 
and/or the Federal Bureau of Investigation has advised us that the above named person was 
charged or convicted as indicated below.  After review of this information the following decision 
has been made: 

 

(  )   Your request to be certified or recertified as a foster parent, approved or reapproved as a       
        relative foster parent or approved as an adoptive parent has been denied.  

 

(  )   Your certification or approval as a foster parent or approval as an adoptive parent has been  
        revoked. 
 

This denial or revocation is because: 

 

DENIAL or REVOCATION (based on a presumptive disqualifying crime)  

 

(  )  You or your spouse has a felony conviction at any time involving: 

  (  )  child abuse or neglect; 

  (  )  spousal abuse; 

  (  )  a crime against a child, including child pornography; or 

  (  )  a crime involving violence, including rape, sexual assault, or homicide,  
       other than a crime involving physical assault or battery. 

 

(  )  You or your spouse has a felony conviction within the past five years for  



 

 

       physical assault, battery, or a drug-related offense. 

 

DISCRETIONARY DENIAL or REVOCATION 

 
(  ) You or your spouse has a felony and/or misdemeanor conviction for any other crime 
      which creates a safety concern with regard to boarding or placing children in your home  
      for the purposes of foster care or adoption. 
       
(  )  Someone else over the age of 18 who resides in your household has a felony and/or 
       misdemeanor conviction for any crime which creates a safety concern with regard to 
       boarding or placing children  in your home for the purposes of foster care or adoption. 
 
(  )  You, your spouse, or someone else over the age of 18 who resides in your household has 

been charged with a crime which creates a safety concern with regard to boarding or 
placing children in your home for the purposes of foster care or adoption.   

 

 

I.  DENIAL/REVOCATION RIGHTS 
 

You are entitled to a copy of the summary of your criminal history record if your application for 
approval or certification to be a foster or adoptive parent or your application for renewal of your 
approval or certification to be a foster parent is denied, or if your approval or certification as a 
foster or adoptive parent is revoked. 

 

If you are a prospective or certified or approved foster parent, or a prospective or approved 
adoptive parent, and your application has been denied or your certification or approval revoked 
by an authorized agency because of a criminal history referenced in this letter (and any 
additional reasons for denial or revocation), you have a right to notice of the reason(s) for denial 
or revocation.   

 

If you are a prospective or approved adoptive parent and your application has been denied or 
your approval revoked, you have the right to request an administrative hearing before OCFS, 
pursuant to Section 372-e of the Social Services Law.  A request for an administrative hearing 
from the Office of Children and Family Services must be made by contacting in writing: 

 

Bureau of Special Hearings 

NYS Office of Children and Family Services 

P.O. Box 1930 

Albany, NY 12201 



 

 

 

Such request must be made within 60 days of the receipt of this notice.   

 

II.  REMOVAL RIGHTS 
 

If a foster child is to be removed or is removed from your home because of a criminal history 
referenced in this letter (and any additional reasons), you have a right to a conference with the 
authorized agency responsible for such removal in accordance with the provisions of 18 
NYCRR 443.5.  If you are not successful at the conference, you may request an administrative 
hearing before OCFS in accordance with Section 400 of the Social Services Law.  As 
applicable, additional information concerning the reasons for the agency action and your rights 
is attached to this letter.  

 

 

III.  SPOUSAL ABUSE EXCEPTION 
 

If your denial or revocation is based upon spousal abuse, and you believe that such offense was 
not spousal abuse because the fact that you were abused was a factor in causing you to commit 
the crime, you may request an administrative hearing from the Office of Children and Family 
Services by contacting in writing at the address noted above: 

 

Such request must be made within 60 days of the receipt of this notice. 

 

IV.  REVIEW OF CRIMINAL HISTORY INFORMATION 
 

If you want to conduct a DCJS Record Review, you should call the Record Review Unit or write 
to the address listed below to request the necessary forms.  All record reviews are conducted 
via mail. 

 

   NYS Division of Criminal Justice Services 

   Criminal History Bureau 

   Record Review Unit - 5th Floor 

   4 Tower Place 

   Albany, New York 12203 

   Phone: (518) 485 - 7675 



 

 

 

If you conduct a Record Review through DCJS and you believe that there are errors on your 
criminal history record which you seek to challenge, you must provide DCJS with the following 
documentation: 

 

Arrest Data 

To modify arrest data (i.e. arrest charges, date of arrest, date of crime)  on your Criminal History 
Record, YOU must contact the arresting agency.  DCJS REQUIRES WRITTEN notification from 
the ARRESTING AGENCY to correct this information.  

 

Disposition Data 

To correct disposition data or to update missing disposition data, YOU must contact the court of 
adjudication and request a CERTIFIED copy of the disposition.  Once you have obtained the 
certified court document, you must forward it to the DCJS Record Review Unit  which will review 
it  and update your Criminal History Record.  Be advised photostatic copies are NOT acceptable 
unless they contain an embossed (raised design) seal from the issuing court. 

 

If you want to conduct an FBI Record Review, please be advised that since the FBI's Criminal 
Justice Information System Division is not the source of the data appearing on Identification 
Records, and obtains all data thereon from fingerprint submissions or related identification forms 
submitted to the FBI by local, state and federal agencies, the responsibility for authentication 
and correction of such data rests upon the contributing agencies.  Therefore, the rules set forth 
for changing, correcting or updating such data requires the subject of an Identification Record 
make application to the original contributing agency (e.g., police department, county court, etc.). 

 

An individual may challenge the information contained in the FBI Identification Record by 
contacting the original agency that submitted the information to the FBI or the state central 
repository in the state in which the arrest or conviction occurred.  These agencies will be able to 
furnish the guidelines for correction of the Record.  The FBI is not authorized to modify the 
Record without written notification form the appropriate criminal justice agency. 

 



 

 

  

CARTA DE DENEGACIÓN/REVOCACIÓN/NOTIFICACIÓN DE RESULTADOS 

DE HUELLAS DIGITALES/DESCUBRIMIENTO DEL HISTORIAL CRIMINAL 

 
 

Fecha:  

Referencia: 

Nombre:  

Fecha de Nacimiento:  

No. de NYSID: 

ID de Agencia:                   

 

 
Estimado(a) Señor/Señora: 
 
De acuerdo a la Sección 378-a de la Ley de Servicios Sociales, la División de Servicios de 
Justicia Criminal del Estado de Nueva York (New York State Division of Criminal Justice 
Services--DCJS) nos ha informado que la persona nombrada más arriba ha sido acusada y 
declarada culpable o condenada por lo indicado más abajo. Después de revisar esta 
información, se ha tomado la siguiente decisión:                                                                    
 
(  )  Su solicitud para ser un padre/madre de crianza certificado o re-certificado, aprobado o 
reaprobado como familiar que asume el papel de padre/madre de crianza, o aprobado como 
padre/madre adoptivo(a) ha sido denegada. 
 
(  )  Su certificación o aprobación como padre/madre de crianza o aprobación como 
padre/madre adoptivo ha sido revocada. 
 
Esta denegación o revocación de debe a: 
 
DENEGACIÓN o REVOCACIÓN (basada en un crimen presunto que lo descalifica)      
 
(  )  Usted o su cónyuge tiene una convicción de felonía que ha involucrado en algún momento: 
                  (  )  el abuso o la negligencia de niños; 
                  (  )  el abuso de un cónyuge; 

(  )  un crimen contra un niño(a), incluyendo pornografía infantil; o 
                  (  )  un crimen involucrando violencia, incluyendo violación, asalto sexual, u 
                         homicidio, u otro que no sea uno que involucre asalto físico o agresión. 
 
(  )  Usted o su cónyuge tiene una convicción de felonía que ha ocurrido dentro de los últimos 
cinco años por asalto físico, agresión, o una ofensa relacionada a drogas. 
 
 
 



 

 

DENEGACIÓN O REVOCACIÓN DISCRECIONAL   
 
(  )  Usted o su cónyuge tiene una convicción de felonía y/o de un delito menor por cualquier 
otro crimen que crea un riesgo de seguridad con respecto al hospedaje o a la colocación de 
niños en su hogar para propósitos de cuidado de crianza o adopción. 
 
(  )  Alguna persona más que reside en su hogar y tiene más de 18 años de edad tiene una 
convicción de felonía y/o de un delito menor por algún crimen que crea un riesgo de seguridad 
con respecto al hospedaje o a la colocación de niños en su hogar para propósitos de cuidado 
de crianza o adopción.  
 
(  )  Usted, su cónyuge, u otra persona mayor de 18 años de edad que reside en su hogar ha 
sido acusado de un crimen que crea un riesgo de seguridad con respecto al hospedaje o a la 
colocación de niños en su hogar para propósitos de cuidado de crianza o adopción.  
    
 
I.  DERECHOS DE DENEGACIÓN/REVOCACIÓN  
 
Usted tiene derecho a recibir una copia del sumario de su historial criminal si su aplicación para 
la aprobación o certificación para ser un padre/madre de crianza o adoptivo o su aplicación 
para la renovación de su aprobación o certificación para ser un padre/madre de crianza es 
denegada, o si su aprobación o certificación como padre/madre de crianza o adoptivo es 
revocada. 
 
Si usted es un padre/madre de cuidado de crianza prospectivo, certificado o aprobado, y su 
aplicación ha sido denegada o su certificación o aprobación revocada por una agencia 
autorizada debido a un historial criminal referenciado en esta carta (y cualquier razón adicional 
para denegar o revocar), usted tiene derecho a ser notificado(a) sobre la denegación o 
revocación. 
 
Si usted es un padre/madre adoptivo prospectivo o aprobado cuya aplicación ha sido denegada 
o su aprobación revocada, usted tiene el derecho de solicitar una audiencia administrativa ante 
OCFS, según la Sección 372-e de la Ley de Servicios Sociales.  Una solicitud para una 
audiencia administrativa de la Oficina de Servicios para Niños y Familias debe efectuarse 
contactándose por escrito con la:                   
 
                   Bureau of Special Hearings 
                   NYS Office of Children and Family Services 
                   P.O. Box 1930 
                   Albany, NY 12201 
                                                                                       
 
Tal solicitud debe hacerse dentro de los 60 días del recibo de esta notificación. 
 
 
II.  DERECHOS DE RETIRO     
 
Si un niño(a) que está bajo cuidado de crianza va a ser retirado o ha sido  retirado de su hogar 
debido a un historial criminal referenciado en esta carta (y cualquier razón adicional), usted 
tiene derecho a una conferencia con la agencia responsable autorizada para efectuar tal retiro, 



 

 

de acuerdo con las provisiones 18 NYCRR 443.5.  Si usted no tiene éxito en la conferencia, 
usted puede solicitar una audiencia administrativa ante OCFS, de acuerdo a la Sección 400 de 
la Ley de Servicios Sociales. Según se aplique, se adjunta a esta carta información adicional 
con respecto a las razones por las que la agencia tomó esta acción y sus derechos.     
                     
 
III.  EXCEPCIÓN REFERENTE AL ABUSO CONYUGAL  
 
Si su denegación o revocación está basada en abuso conyugal, y usted cree que tal ofensa no 
constituyó abuso conyugal debido a que el hecho de que usted fue abusada(o) fue un factor 
que ocasionó su crimen contra su esposo(a), usted puede solicitar una audiencia administrativa 
de  la Oficina de Servicios para Niños y Familias contactándose por escrito a la dirección 
anotada más arriba: 
 
Tal solicitud debe hacerse dentro de los 60 días del recibo de esta notificación. 
 
 
IV.  REVISIÓN DE LA INFORMACIÓN DEL HISTORIAL CRIMINAL   
 
Si usted desea una Revisión del Historial de DCJS, usted debería llamar a la Unidad de 
Revisión de Historiales o escribir a la dirección siguiente para solicitar los formularios 
necesarios. Todas las revisiones de historiales se llevan a cabo por correo. 
 
                   NYS Division of Criminal Justice Services 
                   Criminal History Bureau 
                   Record Review Unit - 5th Floor 
                   4 Tower Place 
                   Albany, New York 12203 
 
                   Teléfono: (518) 485-7675 
 
Si usted lleva a cabo una Revisión de Historiales a través de DCJS y usted cree que hay 
errores en  su historial criminal, el mismo que usted  trata de recusar, usted debe proveer a 
DCJS la siguiente documentación:      
 
Datos del Arresto
Para modificar los datos del arresto (i.e. acusación del arresto, fecha del arresto, fecha del 
crimen) en su Historial Criminal, USTED debe contactar a la agencia con potestad de detener. 
DCJS REQUIERE NOTIFICACION POR ESCRITO de la AGENCIA CON POTESTAD DE 
DETENER para corregir esta información. 
 
Disposición de Datos
Para corregir la disposición de datos o para actualizar los datos de disposición que faltan, 
USTED debe contactar al tribunal adjudicante y solicitar una copia de la disposición 
CERTIFICADA. Una vez que usted haya obtenido el documento judicial certificado, usted debe 
enviarlo a la Unidad de Revisión de Historiales de DCJS, la que la revisará y actualizará su 
Historial Criminal. Por favor note que copias fotostáticas NO son aceptables, a menos que 
contenga el sello de la corte emisora en relieve.    
 



 

 

Si usted desea llevar a cabo una Revisión del Historial del FBI, por favor tome en cuenta que 
debido a que la División de Sistemas de Información de Justicia Criminal del FBI (Criminal 
Justice Information System Division) no es la fuente de los datos que aparecen en los 
Historiales de Identificación, y obtiene todos los datos siguientes a través de huellas digitales o 
impresiones dactilares u otros formularios de identificación presentados al FBI por agencias 
locales, estatales y federales, la responsabilidad de autentificar y corregir los datos depende de 
las agencias contribuyentes.  Por lo tanto, las regulaciones establecidas para cambiar, corregir 
o actualizar tales datos requiere que el sujeto de un Historial de Identificación presente una 
aplicación a la agencia contribuyente original (por ejemplo, el departamento de la policía, el 
tribunal del condado, etc.). 
 

Un individuo puede disputar la información contenida en el Historial de Identificación del FBI 
poniéndose en contacto con la agencia que presentó la información al FBI o al repositorio 
central del estado donde ocurrió el arresto o la convicción. Estas agencias podrán proveer las 
normas para corregir el historial.  El FBI no está autorizado a modificar el historial sin una 
notificación escrita de la agencia criminal de justicia apropiada.  



 

 

 

 

 

 
Appendix B: 

 
Foster Care Issues Section of FASP Report (Example) 



 

 

 

SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 
     
Stage Name: Smith, Jane Stage ID: 23758563  
Case Initiation Date: 01/01/2006 Report Date: 03/01/2007  
LDSS with Case Management: LIVINGTON LDSS/Agy with Case Planning:   
 

 

 

FAMILY ASSESSMENT AND SERVICE PLAN (FASP) INFORMATION 
 

FASP Type:  Reassessment FASP Status:  In Process FASP Due Date:  05/03/2007
 
 

WORKER INFORMATION 
 

WORKER NAME ROLE ASSOC. CHILD(REN) AGENCY/COUNTY UNIT
Bascom,Michelle Case Manager  Albany County Dss 140 

 
 

FAMILY SERVICES STAGE COMPOSITION INFORMATION 
 

Last, First Middle Sfx DOB Age Caretaker
Smith, Jane M 01/01/1975 32 Primary Caretaker 

Smith, David S 12/01/1972 35 Secondary Caretaker 

Smith, William 11/12/2001 16  

Smith, Mary 03/05/2006 1  

 
    

Smith, William    

    

Program Choice/PPG Eff. Date Anti. Comp. 
Date

Sub. Category

Protective 09/24/2005   

Placement 09/24/2005   

Place in another planned living arrangement 10/07/2004 10/31/2005 Discharge to independent living 

Reason for Change: Child old enough to live by himself.  

  

PLACEMENT 
INFORMATION 

 

Facility Name: Anderson, Artrude Placement Date: 02/07/2007 



 

 

Facility Location: 645 WESTCHESTER AVE, APT 6A 

BRONX, NY 10455-1668 

Facility Type: Approved Relative Foster Home 

Out of County Indicator: No Reason:  

Out of State Indicator:  Reason:  

Reason for Transfer  Data Source: CCRS 

    

 
    

Smith, Mary    

    

Program Choice/PPG Eff. Date Anti. Comp. 
Date

Sub. Category

Protective 09/24/2005   

Non-LDSS Custody – Relative/Resource 09/24/2005   

Placement 09/24/2005   

Legalize living Arrangement with relative/Resource 10/07/2004 10/31/2005  

Reason for Change:  
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SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - ACTIVITIES PRIOR TO PLACEMENT 
 

Griffin,Danielle R Age:  3 Program Choice 1: Placement 
   Program Choice 2: Protective 

 
Discuss the reasons for placement and the alternatives to placement considered, including services offered and 
reasonable efforts made to avert placement. Include efforts made to identify and evaluate the suitability of the non-
respondent parent, other relatives or other suitable persons as resources. 
Children are left unsupervised for short periods of time. 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - LOCATION OF CHILD 
 

Is the child placed a substantial distance from his/her siblings? (Include situations where sibling(s) move a No 



 

 

substantial distance or out-of-state after the child is placed.) For NYC only: Include children placed outside their 
community district. 

 
What are the service needs the child has which cannot be met at a lower level of care? 
Children are autistic 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - CONTINUITY OF ENVIRONMENT 
 

Are all siblings placed in the same home? Yes 
 

Does the Placement permit:   
Family Contact:  Yes Continuity with the Child's Community?  Yes 
Sibling Contact:  Yes Continuity with the Parent's Religious Preference?  Yes 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - CONTINUITY OF CULTURE FOR AMERICAN 
INDIAN CHILDREN 

 
Is the child in placement an American Indian Child? No 

 
 

FOSTER CARE ISSUES - ADJUSTMENT AND FUNCTIONING - ADJUSTMENT IN FOSTER CARE  
 

For each child in foster care, describe the child's response to separation and loss and the child's functioning and overall 
well-being in their current placement. Also explain how this placement is the most appropriate setting to meet the child's 
current service and health needs and whether it is the least restrictive and most home like setting required to support the 
child's well-being; if appropriate, include a description of the child's response to any moves from one foster care setting to 
another. 
Danielle is having trouble adjusting to her new surroundings.  She is having behavioral problems which seem to reflect poorly on her 
younger sibling. 

 
 

FOSTER CARE ISSUES - ADJUSTMENT AND FUNCTIONING - SAFETY IN FOSTER CARE 
 

Identify and describe protecting factors that keep the child safe in this placement. 
Danielle is having trouble adjusting to her new surroundings.  She is having behavioral problems which seem to reflect poorly on her 
younger sibling. 

 
Since the last FASP, are there any safety related issues in the current placement? No 
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SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - PROGRESS TOWARDS 
PERMANENCY 

 
Describe the positive progress made to achieve the permanency goal. Describe the parent's, relative's, or primary resource 
person's involvement in planning for the child's discharge. Specify any barriers to timely permanency. 
The mother is taking parenting classes and understands the outcome of leaving a young child unsupervised. 

 



 

 

 
FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - TERMINATION OF 
PARENTAL RIGHTS PETITION 

 
Has the child been in foster care for 15 of the past 22 months?  No 
  
Has the child in foster care been determined by a court to be an abandoned child? No 
  
Has a court determined that the parent of this child committed a serious crime against this child or another of 
their children?   

No 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - PARENT LOCATION 
 

Have all parents been identified? Yes 
 

Have all parents been located? Yes 
 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - ALTERNATIVE 
PERMANENCY RESOURCES 

 
Have you explored alternative permanency resources that may be available to the child should he or she be 
unable to return home? 

Yes 

 
Have any potential resources been identified? Who are they? 
The Grandmother will take the girls. 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - CONCURRENT PLANNING 
DISCUSSION WITH PARENTS 

 
Have you discussed concurrent planning and alternative permanency resources(including foster parents)with 
the parents? 

Yes 

 
Describe the parent's response. 
The mother wants the girls to live with her 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - CONCURRENT PLANNING 
DISCUSSION WITH FOSTER PARENTS 

 
If the child has been in placement 3 months or more, have the foster parents been asked whether they would 
consider adopting the child, should the child become free for adoption, or otherwise provide a permanent living 
arrangement for the child? 

No 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - ADOPTION DISCUSSION 
 

For a child in placement for six months or more, have you discussed with the child's parent(s) the signing of a 
voluntary surrender, including, where appropriate, a conditional surrender?  

No 
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SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 

 
 



 

 

 
FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - ACTIVITIES PRIOR TO PLACEMENT 

 
Griffin,Cassidy L Age:  2 Program Choice 1: Placement 
   Program Choice 2: Protective 

 
Discuss the reasons for placement and the alternatives to placement considered, including services offered and 
reasonable efforts made to avert placement. Include efforts made to identify and evaluate the suitability of the non-
respondent parent, other relatives or other suitable persons as resources. 
Children are left unsupervised for short periods of time. 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - LOCATION OF CHILD 
 

Is the child placed a substantial distance from his/her siblings? (Include situations where sibling(s) move a 
substantial distance or out-of-state after the child is placed.) For NYC only: Include children placed outside 
their community district. 

No 

 
What are the service needs the child has which cannot be met at a lower level of care? 
Children are autistic 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - CONTINUITY OF ENVIRONMENT 
 

Are all siblings placed in the same home? Yes 
 

Does the Placement permit:   
Family Contact:  Yes Continuity with the Child's Community?  Yes 
Sibling Contact:  Yes Continuity with the Parent's Religious Preference?  Yes 

 
 

FOSTER CARE ISSUES - APPROPRIATENESS OF PLACEMENT - CONTINUITY OF CULTURE FOR AMERICAN 
INDIAN CHILDREN 

 
Is the child in placement an American Indian Child? No 

 
 

FOSTER CARE ISSUES - ADJUSTMENT AND FUNCTIONING - ADJUSTMENT IN FOSTER CARE  
 
For each child in foster care, describe the child's response to separation and loss and the child's functioning and overall 
well-being in their current placement. Also explain how this placement is the most appropriate setting to meet the child's 
current service and health needs and whether it is the least restrictive and most home like setting required to support the 
child's well-being; if appropriate, include a description of the child's response to any moves from one foster care setting to 
another. 
Cassidy is adjusting wrll in the new foster care setting. 

 
 

FOSTER CARE ISSUES - ADJUSTMENT AND FUNCTIONING - SAFETY IN FOSTER CARE 
 

Identify and describe protecting factors that keep the child safe in this placement. 
Warm and supportive home 

 
Since the last FASP, are there any safety related issues in the current placement? No 
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SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 

 
 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - PROGRESS TOWARDS 
PERMANENCY 
 
Describe the positive progress made to achieve the permanency goal. Describe the parent's, relative's, or primary resource 
person's involvement in planning for the child's discharge. Specify any barriers to timely permanency. 
The mother is taking parenting classes and understands the outcome of leaving a young child unsupervised. 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - TERMINATION OF 
PARENTAL RIGHTS PETITION 

 
Has the child been in foster care for 15 of the past 22 months?  No 
  
Has the child in foster care been determined by a court to be an abandoned child? No 
  
Has a court determined that the parent of this child committed a serious crime against this child or another of 
their children?   

No 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - PARENT LOCATION 
 

Have all parents been identified? Yes 
 

Have all parents been located? Yes 
 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - ALTERNATIVE 
PERMANENCY RESOURCES 

 
Have you explored alternative permanency resources that may be available to the child should he or she be 
unable to return home? 

Yes 

 
Have any potential resources been identified? Who are they? 
The Grandmother will take the girls. 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - CONCURRENT PLANNING 
DISCUSSION WITH PARENTS 

 
Have you discussed concurrent planning and alternative permanency resources(including foster parents)with 
the parents? 

Yes 

 
Describe the parent's response. 
The mother wants the girls to live with her 

 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - CONCURRENT PLANNING 
DISCUSSION WITH FOSTER PARENTS 

 
If the child has been in placement 3 months or more, have the foster parents been asked whether they would 
consider adopting the child, should the child become free for adoption, or otherwise provide a permanent living 

No 



 

 

arrangement for the child? 
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SENSITIVE CASE FAMILY ASSESSMENT AND SERVICE PLAN *****WARNING***** 
  CONFIDENTIAL INFORMATION 
  AUTHORIZED PERSONNEL ONLY 
Case Name: Smith, Jane Case ID: 21797392 DRAFT 

 
 
 

FOSTER CARE ISSUES - PERMANENCY PROGRESS/CONCURRENT PLANNING - ADOPTION DISCUSSION 
 

For a child in placement for six months or more, have you discussed with the child's parent(s) the signing of a 
voluntary surrender, including, where appropriate, a conditional surrender?  

No 

 
 

FOSTER CARE ISSUES  - FAMILY/CHILD VISITING PLAN 
 

Review Status Plan Description Primary Location Frequency Duration Visiting Plan Status
Not Applicable Parents/Child(ren) Foster Home Multiple times per week 1 to 2 hours Active 

 
Children Adults Other Participants
Griffin,Danielle R 
Griffin,Cassidy L 

Crowley,Rebekah K  
 

Are there any special conditions (i.e. court orders, supervised visitation, phone contacts, mail) regarding 
visitation?   

No 

 
Is assistance necessary to facilitate visitation?   No 

 
Describe specifically what will occur during visits to enhance parental capability, support the parent/child relationship and 
support the child's well-being: 
The mother is interacting with her children in a productive way. 
 
Provide any additional detail regarding location, frequency, or duration of the visiting plan: 
Mother shows up at scheduled visits on time and with a productive attitude. 

 
 

FOSTER CARE ISSUES  - NO VISITING PLAN 
 

For any child without a visiting plan with a parent, legal guardian/custodian or primary discharge resource, explain why 
there is no active visiting plan.  If a child has contact but does not visit, describe the contact. 

 
FOSTER CASE ISSUES - VISITING GRID 

 
Visitation Information from Progress Notes from  11/03/2006  to  03/15/2007 

 
Date of Visit Type of Visit Participants Location 
    

 
 
 

End of the Report 
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